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QUESTION 1

Which two actions are always necessary when deploying Forms applications that were developed on Windows platform
to a UNIX middle tier server? 

A. moving the forms executable files from the development machine to the middle-tier machine 

B. compiling the Forms modules on the middle tier machine 

C. creating a menu module for the application 

D. compiling the Forms modules on the development machine 

E. moving the Forms source files from the development machine to the middle tier machine 

F. creating a Forms PL/SQL library file to contain the application logic 

G. installing forms Builder on the middle-tier machine 

Correct Answer: AD 

Once you have created your application in Forms Developer, you are ready for application Web 

deployment. Oracle Forms Services accesses an application in Oracle Fusion Middleware through a 

specified URL. The URL then accesses the HTTP Listener, which communicates with the Listener Servlet. 

The Listener Servlet starts a Forms run- time process (frmweb.exe on Windows or frmweb on UNIX and 

Linux) for each Forms Services session. 

Note: 

To deploy a basic form with the default parameters set up by the installer: 

1. 

Create your application in Forms Developer and save it. The .fmb file is a design time file that can only 

be opened in Forms Developer. The .fmx file is the run-time file created when you compile the .fmb and is 

used for Web deployment. 

2. 

Modify the formsweb.cfg file so that Oracle Forms Services can access your application module. 

3. 

Make sure the .fmx file location is specified in the FORMS_PATH environment variable. 

4. 

To modify an environment file, select the file in the Environment Configuration page of Fusion 
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Middleware Control and add or edit environment variables as needed by your application 

5. 

Enter the name of your application in the URL as shown: 

http://example.com:8888/forms/frmservlet? 

where "example" is the hostname of your computer and "8888" is the port used by your HTTP Listener. 

Once you have created a configuration section, add "config=" and the name of the configuration section. In 

this example, the URL to access hrapp.fmx is: 

http://example.com:8888/forms/frmservlet?config=my_ 

application 

 

QUESTION 2

Which setting of :SYSTEM.MESSAGE_LEVEL suppresses all system messages? 

A. 0 

B. 10 

C. 25 

D. 50 

E. You cannot use :SYSTEM.MESSAGE_LEVEL to suppress all system messages 

Correct Answer: E 

Controlling System Messages You can prevent system messages from being issued, based on their severity level.
FormsBuilder classifies every message with a severity level that indicates how critical or trivial the information is; the
higher the numbers, the more critical the message. There are six levels that you can affect. 

Note: Suppressing Messages According to Their Severity In a trigger, you can specify that only messages above a
specified severity level are to be issuedby the form. You do this by assigning a value to the MESSAGE_LEVEL system
variable. Formsthen issues only those messages that are above the severity level defined in this variable.The default
value for MESSAGE_LEVEL (at form startup) is 0. This means that messages of all severities are displayed. 
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QUESTION 3

View the Exhibit. 

You have just created a new object library as shown in the Exhibit. You want the tabs to have descriptive names. 

You cannot change the names of the default object library tabs, so you must create new tabs in order to have
descriptive names. 

A. True 

B. False 

Correct Answer: B 

 

 

QUESTION 4

View the Exhibit. 
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Iin the Human Resources form shown in the Exhibit, you want to modify the prompts, heights, and widths of the
Department Id, Manager Id, and Location Id Holds in the Departments data block. 

What must you select before invoking the Layout Wizard in reentrant mode to modify these item properties? 

A. Frame5 

B. Frames 

C. Canvas4 

D. the Departments block 

E. the DEPARTMENT_ID, MANAGER_ID and LOCATION_ID items 

Correct Answer: C 

From the exhibit we see that Department Id, Manager Id, and Location Id are all present on Canvas4. 

 

QUESTION 5

What happens when you click Run Form Debug in Forms Builder? 

A. The form runs on your local machine by using a debug executable client. 

B. The form runs in a three-tier environment by using the application server URL that you specify in runtime
preferences. 

C. The form runs in a three tier environment by using the [debug] configuration in the FORMSWEB.CFG file. 

D. The form runs in a simulated three-tier environment by using an applet viewer that is included with the product to
enable debugging. 
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Correct Answer: B 

Directly from the class materials from Oracle: As in the case when you run a form from Forms Builder with the Run Form
button, the Run Form Debug button runs the form in a three-tier environment. It takes its settings from the Preferences
window that you access by selecting Edit > Preferences from the main menu and clicking the Runtime tab. 

 

QUESTION 6

Your company applies three different interest rates for customers based on their credit rating, which is classified as
being Excellent, Fair, Poor or Unknown. 

In the years past, clerks entered credit ratings manually, which resulted in some of them being mistyped. To improve
data entry accuracy you modify the Customers form so that the Credit_Rating item is a static list item that allows only
those four values. 

Users report to you that some of the customer records can no longer be accessed when they use the modified
Customers form. How can you fix this problem? 

A. Ensure that required is set to No for the list item so that a blank line appears in the list. 

B. Set the Mapping of Other Values property for the list item. 

C. Set the Default Value property for the list item. 

D. Set the Query Allowed Property for the list Item. 

E. Users must re-enter the records for those customers that cannot be accessed. 

Correct Answer: B 

The important property is the "mapping of other values." This property tells Oracle Forms how to handle values that are
not expected. 

 

QUESTION 7

Which type of variable must be declared before it is used in a trigger? 

A. PL/SQL variable 

B. Form item 

C. global variable 

D. system variable 

E. parameter 

Correct Answer: A 

PL/SQL is the language used in Forms triggers and program units. 

PL/SQL lets you declare variables and constants, then use them in SQL and procedural statements anywhere an
expression can be used. You must declare a constant or variable before referencing it in any other statements. 
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Variables can have any SQL datatype, such as CHAR, DATE, or NUMBER, or a PL/SQL-only datatype, such as
BOOLEAN orPLS_INTEGER. 

Note: 

PL/SQL\\'s data types correspond with SQL\\'s column types, making it easy to interchange PL/SQL variables with data
inside a table. 

 

QUESTION 8

You do not want users to execute queries while in the Order_Items block, so you write the following key-Exeqry trigger
for the Order_Items block: 

GO_BLOCK(\\'orders\\'); EXECUTE_QUERY; 

This works fine except that in the Order_Items block, when you click Enter Query first, and then click Execute Query,
you get the error message "FRM-41009: Function key not allowed." What can you do correct this? 

A. Set the Fire in Enter-Query Mode property of the Key-Exeqry trigger to Yes. 

B. Add the following as the first of the key-Exqry trigger to Yes. SYSTEM.mode := \\'NORMAL\\'; 

C. Delete the Key-Exqry trigger and define the following Key-Entqry trigger for the Order_Items block: GO_BLOCK
(\\'orders\\'); ENTER_QUERY; 

D. Delete the Key-Exqry trigger and define the following Key-Entqry trigger for the Order_Items block: ENTER_QUERY;
GO_BLOCK (\\'orders\\'); 

E. Change the key-Exqry trigger to: IF : SYSTEM.MODE := \\'ENTER-QUERY\\' THEN GO_BLOCK (\\'orders\\');
EXECUTE_QUERY; ELSE MESSAGE (\\'you cannot execute a query for the Order_Items block\\'): END IF; Define the
following Key-Entqry trigger for the Order_Items block: GO_BLOCK (\\'orders\\'); ENTER_QUERY 

F. Change the Key-Exeqry trigger to: IF :SYSTEM.MODE != \\'ENTER-QUERY\\' THEN GO_BLOCK(\\'orders\\');
EXECUTE_QUERY; ELSE MESSAGE (\\'You cannot execute a query in this block\\'); ENTER_QUERY; GO_BLOCK
(\\'orders\\'); 

G. You cannot change this behavior, but you should use the On-Message trigger to display a more meaningful
message. 

Correct Answer: C 

Note: You can use system variables and built-ins to obtain information about queries. 

Using SYSTEM.mode 

Use the SYSTEM.mode system variable to obtain the form mode. The three values are NORMAL , 

ENTER_QUERY , and QUERY. 

NORMAL Indicates that the form is currently in normal processing mode. ENTER-QUERY Indicates that 

the form is currently in Enter Query mode. QUERY Indicates that the form is currently in fetch processing 

mode, meaning that a query is currently being processed. 
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Note 1: ENTER_QUERY procedure 

Clears the current block and creates a sample record. Operators can then specify query conditions before 

executing the query with a menu or button command.If there are changes to commit, the Forms Builder 

prompts the operator to commit them before continuing ENTER- QUERY processing 

Note 2: EXECUTE_QUERY procedure 

Clears the current block, opens a query, and fetches anumber of selected records. If there are changes 

tocommit, Forms Builder prompts the operator to committhem before continuing EXECUTE-

QUERYprocessin 

 

QUESTION 9

You have the Orders form open in Forms Builder. You create an object group in the Orders form and try to drag various
components in the Object Navigator to the object group. 

Which two components will you be unable to place in the object group? 

A. the Orders block of the Orders form 

B. the Order_CV canvas of the Orders form 

C. the When-New-Item- instance trigger of the Order_Items.Quantity item in the Orders form 

D. the When-New Form-instance trigger of the Orders form 

E. the Product_id item in the Order_Items block of the Orders form 

Correct Answer: CE 

C: Object libraries can contain individual items; for example, iconic buttons. The smallest unit accepted in an object
group is a block. 

E: Including a block in an object group also includes its items, the item-level triggers, the block- level triggers and the
relations. You cannot use any of these objects in an object group without the block. 

Incorrect answers: 

A: Including a block in an object group also includes its items, the item-level triggers, the block- level triggers and the
relations 

Note: An object group is a logical container for a set of Forms Builder objects. You need to define an object group when
you want to package related objects for copying or subclassing in another module or if you want to bundle numerous
objects into higher-level building blocks that you can use again in another application. You can package the various
objects in an object group and copy the entire bundle in one operation. 

 

QUESTION 10
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You have created a complex menu structure with several types of menu objects. To which objects would you assign
menu commands? 

A. main menus 

B. individual menus 

C. submenus 

D. menu items 

E. all of the above 

Correct Answer: E 

The Menu Editor is a graphical design facility for laying out, modifying, and viewing menu modules and 

their objects. You can use the Menu Editor to carry out all of your menu design work. 

Note: 

To use the Menu Editor to create a basic structure for your menu, perform the following steps: 

1 . 

With the SUMMIT_MENU module selected, perform one of the following actions to invoke the Menu Editor: 

Double-click the icon to the left of the module Right-click the module and select Menu Editor Select Tools > Menu Editor
from the Forms Builder menu 

2 . 

When you invoke the Menu Editor, it automatically creates the main menu and one menu item. The main menu is the
menu whose items, which can be menu items or submenus, show in the menu bar when you run a form. 

In the Object Navigator, change the name of the main menu to MAIN_MENU in the same way that you changed the
name of the menu module. 

3 . 

In the Object Navigator, change the name of the menu item to File. 

4 . 

Note that the item\\'s display label in the Menu Editor remains the same. 

The label is the text that is displayed for the menu item at run time. The label may differ from the name. 

You use the name programmatically, and it must follow PL/SQL naming conventions. 

Change the label of the menu item by double-clicking in the Menu Editor and typing the new 

label of File. 

5 . 

Create two menu items under File. In the Menu Editor, select File, then click Create Down twice. 
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6 . 

In the Menu Editor, relabel the menu items to Save and Exit. 

Note that creating menu items under the File object creates a FILE_MENU object as a menu with two 

items under it. Also, when you relabel the items in the Menu Editor, the names of the items, as shown in 

the Object Navigator, also change. 

7 . 

Create another submenu of the main menu and label it Edit by performing the following steps: 

In the Menu Editor, select the File node. 

Click Create Right. 

Relabel the new menu Edit. 

8 . 

In a similar fashion to the way you created the File menu items, create two items for the Edit menu labeled 

Copy and Paste. 

9 . 

You can also use the Object Navigator to add a menu item. 

Under the Edit_Menu in the Object Navigator, select the Items node and click Create. 

10 . 

In the same way as you did with other items, relabel the new item in the Menu Editor with the label Cut, 

which also renames it in the Object Navigator. 

Reference: Creating Oracle Forms Menus 

 

QUESTION 11

You have written a Forms application that your users log in to with their database login. Which Forms component is
utilized first when a user runs the application? 

A. Forms Client (applet) 

B. Forms Runtime 

C. Forms Servlet 

D. Forms Listener Servlet 

Correct Answer: A 
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Note: ORACLE APPLICATION SERVER FORMS SERVICES ARCHITECTURE The OracleAS Forms Services consists
of three components: a Forms Client that is downloaded automatically to the end user\\'s browser and cached, the
Forms Listener Servlet, and the Forms Runtime - on the middle tier. 

Forms Client (Java Applet) When a user runs a Forms session, the Forms Client - a thin 100 percent Java Applet -
dynamically downloads from the Oracle Application Server. This generic Java Applet provides the user interface for the
associated Forms Runtime process on the middle tier, and handles user interaction and visual feedback such as that
generated by navigating between items or checking a checkbox. The same Java applet is used for any Forms
application, therefore it is downloaded only once and cached on the client and so is available for subsequent Forms
applications 

 

QUESTION 12

You have been assigned to maintain the Orders form. Users complain that if the cursor is in the in the Orders block,
they cannot navigate to the Order Items block by clicking a text item in that block. They must click the Next Block button
to navigate from the Orders block to the Order Items block. 

How should you investigate the source of the problem? 

A. Check the Pre-Text-Item and Post-Text-Item triggers, because users may be encountering a navigation trap. 

B. Check the Navigation properties of the Orders block that have non-default values. 

C. Check the Navigation properties of the Order Items block that have non-default values. 

D. Check the Navigation properties of the items in the Orders block that have non-default values. 

E. Check the Navigation properties of the form that have non-default values. 

F. Check that the items in the Order Items block are enabled. 

Correct Answer: A 

The Navigation Trap You have seen that the Pre-and Post-navigation triggers fire during navigation, and when they fail
the internal cursor attempts to return to the current item(SYSTEM.CURSOR_ITEM).The diagram below illustrates the
navigation trap. This can occur when a Pre-or Post-navigation trigger fails and attempts to return the logical cursor to its
initial item. However, if the initial item has a Pre-Text-Item trigger that also fails the cursor has nowhere to go, and a
fatal error occurs. Note: Be sure to code against navigation trigger failure 
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QUESTION 13

The Employees database table contains more columns than can be displayed at one time in a form. You create a data
block that uses all the columns. How can you enable users to interact with all the items and switch between them
without scrolling or closing anything? 

A. Define multiple content canvases and display them in multiple modeless windows. 

B. Define multiple content canvases and display them in the same modeless window. 

C. Define multiple content canvases and display them in multiple modal windows. 

D. Define multiple content canvases; display one in a modeless window and the others in modal windows. 

E. This is not possible because items from a single block must be displayed on the same canvas and window. 

Correct Answer: D 

 

Note 1: 

The most common canvas type is the content canvas (the default type). A content canvas is the "base" 

view that occupies the entire content pane of the window in which it is displayed. You must define at least 

one content canvas for each window you create. 

Note 2: 

Modal and Modeless Windows in Oracle Forms 
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A window in oracle forms is a container for all visual objects that make up a Forms application. You can 

create two different type of windows in oracle forms. Lets have a brief comparisons between these two 

types of windows. 

* 

Modal Window: A modal window is a restricted window that the user must respond to before moving the input focus to
another window. Modal windows: Must be dismissed before control can be returned to a modeless window Become
active as soon as they display Require a means of exit or dismissal 

* 

Modeless Window: A modeless window is an unrestricted window that the user can exit freely. Modeless windows: Can
display many at once Are not necessarily active when displayed Are the default window type 

 

QUESTION 14

You want to use the Forms Debugger to diagnose a problem with the RAISE_STATUS program unit that is stored in the
database. 

Forms Builder, you set a breakpoint in the stored code, and then run the Human Resources form in debug mode. You
click the Raise_Salaries button, which has a When Button Pressed trigger that calls RAISE_SALARIES. 

However, you are unable to see the RAISE_SALARIES procedure when you step through the code, and it does not
appear in the stack frame. What could be the reason for this problem? 

A. You are not connected to the database. 

B. The stored program unit was not compiled with the debug information included. 

C. The breakpoint should have been set in the When-Button-Pressed trigger, not in the stored program unit. 

D. You cannot use the Forms Debugger to diagnose problems with stored program units. 

Correct Answer: D 

The Forms debugger can only step through Forms side code, not database side code. If you Form calls a database
procedure, you will not be able to see what it does through the Forms debugger. 

 

QUESTION 15

The Orders form has the following triggers defined: 

1. 

Post-Text-Item on Customer_Id 

2. 

Pre-Text-Item on Sales_Rep_Id 
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3. 

When-New-Item-instance on Sales_Rep_Id 

The form\\'s Validation Unit property is set to Record. 

When the user navigates from Customer_Id to Sales_Rep_Id, which triggers fire and what is the sequence? 

A. 1, 2, and 3 

B. 1, 3, and 2 

C. 1 and 2 only 

D. 2 and 3 only 

E. 3 only 

Correct Answer: A 

All three triggers fire when you navigate 
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